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Text styles in Help—What do they mean?
To enhance your Zywave Help experience, we use the following styles to highlight important
information you cannot miss. Whether you need to go to a specific tool page and click a button
or you're in need of a helpful tip, the following styles will guide you through our Help resources
with ease.

Style Description

Bold text (In a font that differs

from the surrounding text)

You should type this text exactly as
shown.

Example: Type
https://www.zywave.com in the
address box of your Internet browser.

Italicized text (In a font that

differs from the surrounding text)

You should replace this text with your
own values.

Example: Type today's date in the
following format: mm/dd/yyyy.

Bold text (In the same font as the surrounding text)

You'll see this text on-screen. It may
appear as a link or button to click.

Example: Click Save to apply your
changes.

Italicized bold gray text

You'll see this text on-screen. It may
appear as a window or menu name.

Example: You can search for a resource

using the Content menu.

Tip:
A tip or hint for using a particular feature
of your application.
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Style Description

Note:

A note that you should be aware of
when using a particular feature of your
application.

Important:

An important note that you should be
aware of when using a particular
feature.

How? How?
A set of instructions on how to use a
feature.

Example: Here is some text giving an example. An example of how to use a feature.
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Workflow of Broker Briefcase®
>>First steps

Karen’s agency has just purchased Broker Briefcase® and has selected to give Karen the admin-
istrator role at their agency. Karen is ready to get started and logs in to Broker Briefcase®.
Upon arriving at the home page, Karen sees banner ads, new content, and the navigation menu.

>>Set up administrative features

Karen wants to customize a few distribution templates for her agency. Afterward, Karen
imports custom content for the producers at her agency to distribute to clients. Next, Karen
adds custom posting categories for the MyWave portal her agency owns.

>>Search for content

Now that Karen has taken care of some key administrative features, she wants to distribute a
few resources to her clients—but first she needs to find the content. She enters a search term in
the search box, then scans theSearch Results page for a resource. To narrow her search results
further, she refines her search using refinement categories and their keyword tags.

>>Distribute content

Karen clicks her desired resource and its Content Details page loads. She determines this
resource could be valuable in the future and marks it as a Favorite, then clicks Action Items to
add the resource to a content group so she can revisit it later. Afterward, Karen decides she
wants to distribute this resource to her clients immediately.

What if she does not have any accounts or contacts listed? Karen will need to import her
accounts and contacts into Account Management Center.

>>Review scheduled distributions

After distributing the resource, Karen clicks Calendar from the main navigation menu to review
scheduled distributions.

>>Run a report

Karen realized the plethora of resources Broker Briefcase® has to offer and would like to see
the other content types available to her. She clicks Reports from the main navigation menu and
runs the Content report to get a detailed list of content that's available.
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Getting started
Broker Briefcase® is your powerhouse content and distribution engine, helping you stay in front
of your clients and prospects.

What is Broker Briefcase®?

Keep your agency indispensable to your clients so you can continue maintaining and winning
business with Broker Briefcase®—your online marketing and communication tool that revo-
lutionizes the way you sell and service.

The content in Broker Briefcase® is vast and written by industry experts devoted to providing
you with original, timely marketing and communication resources. Log in to one location for all
the benefits, property and casualty, and personal lines information you need.

Broker Briefcase® is a proven product, built by brokers for brokers, specifically for the way
brokers work. It will allow your agency to:

l Differentiate itself from your competitors.

l Attract new business.

l Continually demonstrate value to existing clients.

l Improve the productivity of its staff and clients.

l Reduce turnover of existing accounts.

Most importantly, Broker Briefcase® is simple. We do the research. We do the writing. We
make it appealing and professional—all you do is point and click.

Types of content
From Microsoft®Word® documents to videos and more, Broker Briefcase® contains a plethora
of valuable content broken down into categories, formatted to help you find content as quickly
as possible. Because Broker Briefcase® content is built using Microsoft®Office® (Word®, Excel®,



Broker Briefcase® User's Guide

Page 14

and PowerPoint®), it is easily accessible and editable. The build process also customizes content
with your agency information and logo, branding the resource to your agency.

How? To view the different types of Broker Briefcase® content available to you, look to the navigation sidebar, then

click Browse.

How Broker Briefcase® customizes content to fit your needs
Content in Broker Briefcase® is designed to fit your branding and speak to your clients and pro-
spects. Your agency and client information is automatically pulled into Broker Briefcase® con-
tent with merge fields.

Example: In the following illustration of a Broker Briefcase® prospecting resource, take note of the highlighted areas.
Each of these areas are merge fields, which include your agency name, logo, tag line, contacts, contact information,
and other related information.
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Broker Briefcase® mobile
Stay cutting-edge and top-of-mind with clients and prospects using Broker Briefcase® mobile.
Present and distribute content directly from your mobile device wherever you are—whether it's
in a client meeting, in the airport, or in a prospect presentation.

How? From your mobile phone or tablet, go to www.brokerbriefcase.com. You'll be automatically redirected to the
mobile site where you can log in with your Zywave credentials. For easy access, tap the pop-up to create a shortcut
on the home screen of your device.
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For more information on how to use Broker Briefcase® with your mobile device, look to Broker Briefcase® mobile Best Practices in
Broker Briefcase® Help > Additional resources.

Logging in

Retrieve your login credentials
Forgot your user name or password? Logging in for the first time? Locked out of your account?
To request a new password for one for one of these reasons:

1. From the Broker Briefcase® login page, click Forgot your password?

2. Enter your email address, then click Continue.

3. From the Instructions for Resetting your Zywave Password email, click Reset Password.

4. Click Reset password for the desired user name you'd like to reset the password for.

Note: This step is only applicable for those with both a broker and client login.

5. On the Reset Your Password page, enter your new password, then click Submit.

After resetting your password, you'll be logged in to Account Management Center and will
receive an email confirming the password change. From Account Management Center, click
the Products drop-down > Broker Briefcase®.

Logging in through Zywave™ Home
1. Go to Zywave™ Home at http://home.zywave.com.

2. If necessary, enter your Username and Password.

3. From the home page, click the Broker Briefcase® thumbnail; or, from the Solutions page,
click Launch next to Broker Briefcase®.

Logging in through Zywave® Sidebar
1. Go to Zywave® Sidebar through the Start menu > Programs > Zywave > Zywave Sidebar.

2. If necessary, enter your Username and Password.

http://home.zywave.com/
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3. Open the Product Launchpad, and click Broker Briefcase®.

Logging in through Account Management Center
1. Go to https://amc.zywave.com.

2. From the top bar, click Products > Broker Briefcase®.

Customizing your Broker Briefcase® settings

Tailor Broker Briefcase® to only show content your clients need and set default distribution set-
tings. To access your user settings, look to the top bar, then click your name. On the Settings
page you can:

https://amc.zywave.com/
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Viewing and servicing your accounts

Search for an account and view it's pending distributions and distribution history. Take it a step
further and send them information they may find interesting from the account's recommended
content—based on past distributions.

Manage accounts
Update account and contact information for clients and prospects.

How? From the Broker Briefcase® navigation menu, look to Communications and selectManage Accounts.

Finding content an account may like
Show your clients just how amazing you are by sending them relevant content they may also be
interested in. Explore a resource's content details page Content you may also be interested in
section to find additional content related to the resource.
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Getting answers to your Broker Briefcase® questions

Looking for quick answers to your most complicated questions? Easily connect with an expert
from our Zywave Partner Support team via instant message; or, receive higher level training
through Zywave University—whether you've just bought Broker Briefcase® and are in the imple-
mentation stage, or you've had the application for a while and need a refresher, there's a pleth-
ora of training resources made just for you!.

Chat live with Zywave experts

How? From the bottom-right corner of the application and click Live Chat.

Note: Live Chat is accessible when online is green; it's unavailable if grayed out. If the Live Chat support window
doesn't open when it's green, you may need to check your browser's Internet options or pop-up blocker.

Zywave University
Take advantage of these free training resources by clicking Need help? in the upper-right of
your top bar.

l On-demand videos

l Product webinars

l Take Action webinars
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l Compliance webinars

l The Form webinars

Other Help resources
If you want to learn the ins and outs of Broker Briefcase®, then don't miss out on Help resources
that house detailed step-by-step instructions and highlight important information. Take a look
at quick reference guides, best practices, and more under Additional resources, and never miss
out on new and updated features by going toWhat's new and clicking on a release date!
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Getting to know the home page
Look to the home page for new content and campaigns, timely resources, and popular topics to
keep your clients informed of the latest and most valuable information.

Discovering valuable content through banner ads

You may be wondering what the flashing images are across the top of your Broker Briefcase®
portal are for. Look to these banner ads for the latest information regarding benefits, property
and casualty, legislative updates, hot topics, and personal lines information.

Note: The banner ads displayed are dependent on the content bundles owned by your agency. For more information,

contact your Zywave Account Executive.
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Checking out the newest content

Take a look at the latest Broker Briefcase® content directly from the home page. In just one
click, see new content in a familiar search results layout.
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Find quick solutions with Take Action

Use the Broker Briefcase® Take action tool to gain insight on strategy tips, recommended con-
tent that will show you the ins and outs of Broker Briefcase®, and learn how to maximize Broker
Briefcase® usage. The Take Action section will be continuously changing to highlight all the dif-
ferent tips and tricks that'll help you use Broker Briefcase® to your full advantage.
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Access helpful resources through Popular Tools

Learn about some of the popular tools that are available to you in Broker Briefcase® in the
Popular Tools section on the homepage. This is updated by our Market Analysts on a regular
basis to keep you up-to-date with the most trendy features being used.
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More homepage tools

Get started
Explore the benefits of Broker Briefcase® and learn how to get started with your client com-
munications by taking a tour, watching videos, or downloading helpful resources.

l Take a tour - Learn how to efficiently complete tasks in Broker Briefcase using guided,
in-product tours. Begin by clicking on a tour name, and follow the on-screen instructions.

l Watch a Zywave University video - Watch videos design to quickly walk you through
Broker Briefcase functionality, workflows, and best practices.

l Help - Looking for some more information? Get started by navigating to Help to browse
through best practices, quick reference guides, and more.

l Sign up for a webinar - Look for the latest webinar offerings, designed to help you get
the most out of Broker Briefcase. Register for a webinar directly from the Get started
page.

l View get started content - Check out some of the top resource to start your Broker
Briefcase exploration, such as Broker Insights, Roadmaps, Campaign Catalogs, and more.

l Read this month's newsletter - Each month, the Broker Brief will highlight new content
and timely, up-to-date resources in Broker Briefcase, which you can use to position your-
self as an expert and trusted advisor.

Browse topics
Access to the Browse Categories page to start discovering all the content Broker Briefcase has
to offer. Use predefined content categories to help quickly narrow down your search to content
you and your clients find valuable.

Send a campaign
Navigate to all Zywave Content Groups to look through a collection of campaigns created by
Zywave with pre-selected distribution dates, and begin setting up a distribution for your clients
and prospects.
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Producer's assistant
Instantly prepare brokers for success. The Producer's Assistant includes resources for any stage
of the sales process and renewals. These quick solutions will help brokers target specific client
needs for more effective sales.
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Searching the content library
The first step to delivering quality content is to find it. The search process in Broker Briefcase®
is designed to help you do just that by yielding an assortment of relevant search results.

Browsing and searching for valuable content

Not sure what you're looking for? In Broker Briefcase® you can Browse hundreds of categories
and their search refinements to discover valuable content. Looking for an exact resource or
have a specific search term in mind? Harness the powerful search engine of Broker Briefcase®
to yield the most comprehensive and accurate results.

Tip: To narrow results, look to the Filter by section, then select additional keyword tags. Sort your search results by
best match, or by most recent.

Browsing for new content
When Browsing for content, select a keyword tag from the list of categories and your search
results will only show content related to that specific keyword tag.

1. From the navigation sidebar, look to Content, then click Browse.

2. Look to a category, then click a keyword tag from that category's search refinement list.

Tip: Select Browse All Categories to see a full list of all content categories.
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Example:
1. From the navigation sidebar, look to Content, then click Browse.

2. From the Browse Categories page, select Browse All Categories, then click Audience.

3. From the Audience section, select Broker.

The search results page will only show content that's been tagged with the keyword Broker.

Searching for an exact resource
When Searching for content, enter a search term and the Search Results page will only show
Broker Briefcase® content containing that specific term.

1. From the search box, choose Content, Content Groups, or Accounts.

2. Enter a search term or phrase in the search box.

3. Press Enter, or click Find (magnifying glass).

4. To narrow results further, from the Filter by section, expand each search refinement's

icon, then select keyword tags.

5. Locate a resource, then click View to access the content details page.
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Example:
You want to provide your client with a risk summary and coverage checklist for their carpenters.

1. In the Broker Briefcase® search bar, select Content, then enter risk summary and coverage

checklist carpenters.

2. Press Enter, or click Find (magnifying glass).

3. From the search results page, locate the document Risk Summary & Coverage Checklist: Carpenters.

Finding a content group

You can use content groups for creating reusable campaigns, drip marketing, and more!

To find out more about using content groups to your full advantage, see "Best practices with using content groups" on page 91.

Searching for a content group
If you know exactly what you're looking for, Search for a content group in Broker Briefcase®.

1. From the Broker Briefcase® search bar, click Content Groups.

2. Enter the name of grouping or campaign you're looking for.

3. Press Enter or click Find (magnifying glass).

Browsing for a content group
If you're not quite sure what you need, Browse already made Zywave content groups or custom
content groups made by users at your agency.
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l Custom content group: From the navigation sidebar, look to Content Groups, then click
My Content Groups.

l Zywave content group: From the navigation sidebar, look to Content Groups, then click
Zywave Content Groups.

Click a group, or campaign, View option to access the details page—where you can view spe-
cifics about this grouping or campaign.

Tip: Sort content alphabetically or by most recent.
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Narrowing and sorting search results
Save time and locate a resource as quickly as possible by adjusting or narrowing your search
results.

Narrowing your search results

To find content you need quickly, narrow your search results to only show content associated
with a specific topic by selecting keyword tags from the Filter by section.

Note: Keyword tags are keywords that content has been tagged with by Zywave experts to help you find content
with ease.

Example:
Your client needs a flyer for their employees to explain the benefits of using a health savings account.
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1. From the search bar, click Content.

2. Enter Wellness as your search term, then press Enter or click Find (magnifying glass).

3. From the Filter by section, click Audience > Employee/Individual.

4. From the Filter by section, click Type/Format > Poster.

Example:
One of your clients often works with transporting hazardous materials and they want to provide their
employees with content on workplace safety.

1. From the search bar, click Content.

2. Enter Hazardous Materialsas your search term, then press Enter or click Find (magnifying glass).

3. From the Filter by section, click Audience > Employee/Individual.

4. From the Filter by section, clickMore filters and select Industry > Transportation andWarehousing.

5. From the Filter by section, clickMore filters and select Safety > Hazardous Materials.

Sorting search results

Organize your search results so they are easier to view by selecting a sort order. From the
search esults page, click the drop-down arrow next to Sort by.

Note: Your search results will automatically be sorted by Best match.
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Running a Search Results report

Analyze search results and find the most valuable resource for your client by running a detailed
report. The Search Results report includes the terms you searched, a list of content that was
found for each term, and a description for each resource.

1. From the top-right of the search results page, click Run report.

2. Select an output Format.

3. Select show all results, or click Show first to select a specific number.

4. To edit the report columns:

l To add a new column, click + Add column.

l To delete an existing column, click the (x) icon on the column you wish to delete.

5. Select whether the report is for an External audience.

Note: If you select External, all your internal agency resources will be removed from the report.

6. Click Export data.
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Viewing content details
Finding quality content was the first step—now take it a step further. Easily find your most com-
monly used content by marketing it as a Favorite, create and send drip marketing campaigns
by storing and grouping content in your Action Items, and much more!

Getting details on the content you find

From reading the content description and viewing its merge fields to reviewing its history and
pending distributions, learn everything you need to know about a resource or content group—
and distribute it—right from the content details page!

How? From the search results page, point to the resource or content group thumbnail, then click View.

Note: Posting is only available to users with client portals.
For more information, contact your Zywave Account Executive.
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Viewing details on a single resource
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Note: Default merge field information cannot be edited from this window.
For more information, contact Partner Support at 866.499.9283.

Viewing details on a content group

Important:
You can edit and delete a content group only if you're the owner or a user with administrative rights. Default content
groups created by Zywave cannot be edited or deleted.

Viewing each resource in a content group
Ensure the content group is a perfect fit for your client or prospect by reviewing each resource
within a content group.
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How? Click the View option on a resource to see more details.

Reviewing the content's pending distributions

Review a resource's Pending distribution dates, recipients, and an option to view more details
from the content details page.

Note: If the Select all accounts recipient option was selected during the scheduling of this distribution, this option

will be listed as the recipient. After the distribution is sent, the distribution History will be updated to show each
individual account that received this resource.
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Previewing and editing content output

Edit content merge fields, Post content to a client portal, Email content to a prospect or client,
or store content in your Action Items from the content details window.

How? From the search results page, click View.

Previewing content with merge fields
View a resource's merge fields from the content details window by clicking Download—as
shown in the following illustration.
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Adding content to your Favorites

Easily find your most commonly used content by marketing it as Favorite.

How? From the content details page, look to the top-left of the content image, then click the star to add to My
Favorites.

Viewing your Favorites
Easily find your most commonly used content by marketing it as Favorite. The resource will be
marked with a star—as shown in the following image—that can been seen anywhere in Broker
Briefcase®. To view all of your Favorites at one time, look to the navigation bar under Content,
then clickMy Favorites.
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Downloading content

View a resource exactly how your clients and prospects will see it by downloading content from
Broker Briefcase®. Content can be downloaded from a variety of places.

Note: Any merge fields in the content will be populated with information from the Broker Briefcase® database. If the
information is not available, the merge field will appear as is, such as [b_officialname].
For more information on why a merge field is unavailable, call Partner Support at 866.499.9283.

Downloading from the search results page
From the Broker Briefcase® home page or search results page, look to the content thumbnail,
then click Download (arrow icon).

Downloading from the content details page
From your search results, click on the content thumbnail to access the content details page,
then click Download.
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Downloading a Spanish version of content
You may want to download and distribute a Spanish version of content to a client for their
employees.

1. Locate a resource that's available in Spanish.

2. From the resource thumbnail, click View.

3. From the content details page, look to the top of the page, then click Spanish from the
drop-down.

4. Click Download.
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Creating and maintaining content groups
Distribute valuable email campaigns when servicing or prospecting clients by creating content
groups.

Grouping content in Action Items

Create a drip marketing campaign with ease from your Action Items—where you can store and
group up to 60 resources. Once you're finished queuing content you need, you can group and
distribute it all from the Action Items at once—with the same streamlined distribution process
used to distribute a single resource.

How? From the content thumbnail flyout menu or the content details window, click Action Items. The count in the

Action Items flyout will change to reflect the addition of the new resource.
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Viewing and managing content in your Action Items
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Creating, editing, or deleting a content group

Easily distribute content targeted to a certain topic, create a reusable drip marketing cam-
paign, or create a distribution that fits your clients exact needs by adding content to your
Action Items and grouping it together.

For more information on how to use a content group to your advantage, see "Best practices with using content groups" on page 91.

Creating a custom content group
Create and maintain custom content groups for yourself or others at your agency. Custom con-
tent groups can be shared with all users at your agency or can be for your use only.

1. Locate a resource you want to add to the content group.

2. From the content thumbnail flyout or content details page, click Action Items ( ).

3. Repeat the previous steps for each resource you'd like to add to the content group.

4. After all desired content is in your Action Items, click the Action Items flyout.

5. From your Action Items, click Save group.

6. From the Create Content Group window, enter a group name and description.

Note: The description will be displayed on the Content Group Details page.

7. Select whether the Visibility of this group is Public or Private.

Note: For a private content group—only visible to the content group owner and users with administrative rights—

make sure the Private option is not selected.

8. Set the distribution dates to:

l No dates: Choose this option if your content group is only meant for organizing con-
tent.

l Actual dates: Choose this option if the content in this group should be sent on spe-
cific dates.
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l Relative dates: Choose this option if the content in this group is typically distributed
on a relative interval, such as weekly or monthly. Choose a start date and the
remaining distribution dates will be set based on the relative interval you've selec-
ted.

Note: The dates you set here will be defaulted for all future distributions of this group, but can be edited

individually from the Content to be sent section in the distribution window.

9. When finished, click Done.

Editing a content group

Note: If you're the owner, or user with administrative rights, you have the ability to edit and delete a content group;
however, content groups created by Zywave cannot be edited or deleted.

1. Look to the Content Groups option on the sidebar, and selectMy Content Groups.

2. Once you've located the content group you wish to edit, select View.

3. From the content details page, click Edit.

4. Make any necessary changes to the properties of the content group.

5. Click Done when finished, or click Cancel to discard all changes made.

Field Description

Content group name Enter a name that reflects the content of this content group.

Description Enter an appropriate description for this content group.

Visibility To create a public content group—visible to all users at your agency—you
must click Public. For a private list—visible only to its owner and users with
administrative rights—select Private.

Distribution dates Set specific or relative distribution dates.

Content This section will list each resource that belongs to this content group. To
remove the respective resource from the distribution group, clickDelete (X).
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Deleting an existing content group

Important:
Once a content group is deleted, it no longer appears in the search results.

Note: If you're the owner, or user with administrative rights, you have the ability to edit and delete a content group;
however, content groups created by Zywave cannot be edited or deleted.

1. Locate the content group through the search feature.

2. Click View to access the content group details.

3. Click Delete.

Adding content to an existing content group

1. Locate a resource you want to add to this content group.

2. Click View to access the content group details page.

3. From the content details page, click Add to Group.

4. From the Create Content Group window, select Existing group.

5. From the Select a content group drop-down, choose a content group to add this content
to.

6. Make any necessary changes, then click Done.

Setting up content group distribution dates

Setting actual distribution dates for content
Content can be set to distribute on specific dates. Each resource can be set up with a unique dis-
tribution and expiration date. This will ensure precise distribution of information that's time-spe-
cific.
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Note: Set default dates for this group by setting distribution dates in the Create Content Group window. These
dates can be edited at any time, allowing you to distribute the content group at your convenience.

Field Description

Content name This section will list each resource that's in this content group.

Note: To remove the respective resource from the content group, click Delete (X).

Send date The date on which this resource is scheduled to be distributed.

Setting relative distribution dates for content
Content can be scheduled to distribute on a relative schedule rather than on specific dates. The
relative distribution schedule allows for a pre-defined schedule of weekly or monthly dis-
tributions, or the creation of a custom schedule. With a custom schedule, a user can send each
resource in a time frame relative to the distribution date of the resource that precedes it.

Tip: Set default dates for content groups by setting distribution dates in the Create Content Group window. These
dates can still be edited at any time, allowing you to distribute the content group whenever you wish.

Field Description

Content name This section will list each of the resources that are a part of this content group.

Note: Remove the respective resource from the content group by clicking Delete (X).

Send content The date on which this resource is scheduled to be distributed.

Select to send content:

l Weekly

l Monthly
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Emailing and posting content
From the content thumbnail flyout or the Content Details page, click Email or Post.

l Email: To distribute campaigns or send content to a specific client, we recommend you
use this distribution method. With emailing you can stay in front of your clients by setting
up campaigns that distribute all-year-round.

l Post: To provide the most up-to-date content to your clients, we recommend you use this
distribution method. As soon as Zywave updates content that you've posted, that content
will automatically update to the current version on your client's portal.

Selecting recipients

How? From the distribution window, look to the To field, then enter or copy and paste a recipient name into the
box.

Using the To button to select recipients
To do a full recipient search for accounts, account contacts, and recipient lists, or to add all
recipients at once: 

1. In the distribution window, click To.

2. From the Search Recipients window, enter a partial or entire contact name in the search
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field.

Note: You can also locate recipients by selecting a group option and browsing through Accounts, Account contacts,
or Lists.

3. Select the account you wish to distribute to by clicking the account name; or, if you only
want to distribute to one contact, click View contacts.

4. If necessary, manually enter recipient email addresses.

Tip: You can also select recipients by clicking the recipient name; or, to send to all valid accounts, click Select all
accounts.

5. When finished, click Confirm.

Tip: Do you frequently find yourself distributing content to the same group of recipients? Save time and create a
recipient list so you can quickly send them content in just one click!
For more information on saving recipients as a list, see "Best practices with distribution" on page 92.

Scheduling and editing the Content to be sent

Manage which content you want to send, how you want to send it, and when you want to send
it, and view and edit merge fields within the content.

1. From the distribution window, look to Content to be sent, then click Edit.

2. If necessary, preview a resource by clicking on its name.

3. Select each resource's Format.

4. If necessary, to fix or edit contentMerge fields:

a. Click Incomplete or Complete, as appropriate.
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b. From the Edit Merge Fields window, make any necessary edits.

c. When finished, click Done.

5. Enter a Send on date for each resource.

6. If posting, enter an Expires on date for each resource.

7. If posting, select a posting category by clicking the Post to column's drop-down for each
resource.

8. If necessary, delete a resource by clicking its (x) icon.

9. When finished, click Done.

Why are some merge fields complete while others are left blank?

In the Edit Merge Fields window, you'll notice that fields are either blank or already complete.
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Merge fields may already be complete because this information is stored in your Zywave applic-
ations, such as your user profile or your agency's profile. When possible, we simplify the pro-
cess of setting up merge fields for you by automatically filling in the fields that we have
information for.

Merge fields may be blank because we don't have information related to this field. It may also
indicate that you're distributing content to an individual that we don't have information for; for
instance, when you manually enter an email address. For more information, contact Partner
Support at 866.499.9283.

Switching the email template

Perhaps you're not satisfied with your default email template for this distribution, so you want
to switch your template to something more topic specific or agency branded. Look no further
than our Email Template Gallery, which houses a plethora of email templates created by
Zywave experts and custom templates created by users at your agency.

Tip: You can save time by setting up an email template to be automatically used for all of your email distributions.
For more information on setting up a default email template, see "Best practices with distribution" on page 92.

1. From the distribution window, look to the Email editor section, then click Switch
template.

2. From the Email Template Gallery, select to view All, Zywave, or Custom templates.

3. Find your desired email template.

4. From the template thumbnail, click Select to return to the distribution window and begin
editing.

Choosing the right email template
Effortlessly engage viewers in your distribution with one of the many eye catching Zywave or
agency custom email templates in Broker Briefcase®.

Zywave templates

Zywave experts have created a plethora of email templates to meet your every day needs.
Select one of these already-made templates and effortlessly edit and customize it section-by-
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section. Zywave templates include: 

l General: None-themed templates that can be used for any piece of Broker Briefcase® con-
tent and edited to fit your needs.

l Workflow: Everyday workflow-based templates that cover sending a phone call or meet-
ing follow up email to distributing breaking news and legislative updates.

l Series-specific: Series-based templates designed specifically for a Broker Briefcase® con-
tent series, such asWorkplace Wellness.

Custom templates

Brand a distribution to your agency by selecting one of the custom email templates made by
users at your agency; or create your own one-off email template from the ground up using
HTML.

Important:

Creating or editing a Classic agency custom email template is suggested for advanced users with CSS and HTML
coding experience.

Editing the email template

Effortlessly edit email templates by clicking on each section within the email template. If the
email template doesn't quite fit your agency needs, quickly add, delete, or reorganize sections.

Note: Only users with administrative rights can save changes to an email template for later use.
For more information, contact your agency administrator.

Getting to know email template sections

Design templates to fit your needs by editing the following sections:
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To edit the background and surrounding color of your email template, access the Edit general
settings section by clicking on the background of the email template preview.

Editing an email template
1. From the Edit Your Email page, edit the template Subject.

2. From the Edit text block field, enter the email message.

3. From the template preview to the right, click on each section to edit it.
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4. To add, delete, or move a section:

l Add: Look to the top of the email template, then click Add sections. From the sec-
tions editor, look to the section you wish to add, then click its Add section button.

l Delete: From the template preview, point to the section, then click its (x) icon.

l Move: From the template preview, point to the section, then click its Up and Down
arrows.

5. To change the Background color and Surrounding color of the template, click the tem-
plate's background to access the Edit general settings field.

Adding an image to an email template
Engage viewers with your email by adding an image from the Banner Image Gallery; or spice
up your email message by adding a colorful image to your text from the Portrait Image
Gallery. Conveniently link your clients and prospects to important information by adding a link
to an image

Important:

These instructions do not apply to Classic agency custom email templates.

Adding a banner image

1. From the Email editor section, look to Add sections > Banner Image, then click Add
section.

2. From the email template, click the Banner Image section to open its editor.

3. Click Change/upload image.

4. From the Banner Image Gallery, select an image; or, click Upload image to upload your
own custom image.

5. Click Select and the image will be added to your email template.

6. As appropriate, hyperlink this image to a site by entering the site's web address.

7. As appropriate, enter text to display if the person you're emailing cannot view this image.
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Adding a portrait image

1. From the Email editor section, look Add sections > Text & Image, then click Add section.

2. To move the section to a different location on the template, point to the section, then
click its Up or Down arrows.

3. From the email template, click the Text & Image section to open its editor.

4. From the section's editor, select Layout, then click the section layout you wish to use.

5. To edit the section's text, click Text, then enter the text and modify it using the text editor
toolbar.

6. To add the image, click Image.

7. Click Change/upload image.

8. From the Portrait Image Gallery, select an image; or, click Upload image to upload your
own custom image.

9. Click Select and the image will be added to your email template.

10. As appropriate, hyperlink this image to a site by entering the site's web address.

11. As appropriate, enter text to display if the person you're emailing cannot view this image.

Inserting merge fields into an email template
Automatically populate a template with your agency and client information by adding the appro-
priate merge fields, such as adding your agency's official name with [b_officialname].

Merge field types

There are a few different types of merge fields that you can add to your email templates:

Important:
Content merge fields are only available to add to Classic agency custom email templates.

l Broker: Select these merge fields to add your agency information to an email template.

l Broker contact: Select these merge fields to add your broker information to an email
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template, such as your name, your title, your email address, and more.

l Client contact: Select these merge fields to add your clients' information to an email tem-
plate, such as their official name, address, phone number, first name, last name, and
more.

l Content: Select these merge fields to add information about the content you are dis-
tributing, such as a content title, content descriptions, and more.

For more information on merge fields, look to theMerge Fields Reference Guide in Broker Briefcase® Help > Additional resources.

How? You can enter or copy and paste a merge field into the text; or, to ensure you have the right merge field and
that it's properly formatted you can: 

1. From the Edit text block section or the Classic template editor, move your cursor to
where you want to insert the merge field on the email template.

2. From the template editor toolbar, click Insert merge fields.

3. From the Insert Merge Fields window, click to view Broker, Broker contact, Client
contact, or Content merge fields.

4. Locate the merge field you want to add, then click Insert.

5. Repeat these steps until all desired merge fields have been added.

Creating a Classic custom email template

Completely customize and brand an email template to your agency by building it from the
ground up using CSS and HTML source code.

Important:
This is recommended for advanced users with CSS and HTML coding experience.

Note: General users can create a Classic email template for one-off distributions; however, only admin users can save

Classic templates they've created for future distributions.
For more information, contact your agency administrator.
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1. From the Email Template Gallery page, look to the bottom of the screen, then click Or,
to use CSS and HTML source code to create your email, click here.

2. From the Email Template Administration page, enter a template Title.

Tip: To use CSS and HTML code, click Source. To preview your CSS & HTML code, click Source again.

3. Place your cursor where you wish to insert a merge field in the email template.

4. From the template editor toolbar, click Insert merge fields.

Important:

You must add at least one Content merge field to your email template.

5. When finished, click Publish.

Adding an image
Engage your viewers by adding an eye-catching image to your Classic email template.

1. From the body, place your cursor where you wish to insert the image, then click Insert
image.

2. From the Classic Image Gallery, look to the All drop-down, then select whether you want
to view All, Zywave, or Custom images.

Tip: To add your own image to the Classic Image Gallery, look to the bottom of the window, then click Upload
image.

3. Click on the image you wish to add, then click Select.

Hyperlinking an image
1. Add an image to the email template, then double click the image.

2. From the Edit text & image section, click Image.
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3. From the Make this image a link to a site by entering that site's web address field,
enter a site web address.

4. From the Enter text to display if the person you're emailing cannot view this image
field, enter link text.

5. When finished, click Publish.

Editing a Classic custom email template
Select and edit an email template that's been built from scratch and completely branded to
your agency by users at your agency. You can identify these email templates from the Email
Template Gallery by the word Classic—placed at the top-left of the template thumbnail.

Important: This is suggested for advanced users with CSS and HTML coding experience.

1. From the Edit Your Email page, edit the template Subject.

2. From the email body, edit any text; or, to edit CSS and HTML code, click Source.

3. As desired, add an image or a hyperlink.

4. When finished, click Publish.
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Viewing the distribution calendar
The Calendar is an essential resource during renewal time; it can help you show the value you
add by assisting you in compiling a stewardship report. The Calendar can also be used to review
and manage your distributions, and to see which clients received each distribution.

Viewing distribution details from the calendar

Whether you're looking up a past distribution or reviewing future distributions, stay on top of
content you're sending to clients from the Broker Briefcase® calender.

Filtering and the calendar
You can quickly find what you're looking for by using the Calendar filtering options.

Viewing distribution details
From the Calendar you can click on a distribution to open the Email Details window and view
more details—such as content that's been distributed, by whom, and when—for that specific dis-
tribution.
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Editing, deleting, and copying a distribution from the calendar

From the Broker Briefcase® Calendar, you can:

l View all past and pending distributions, find the content, and edit it as required.

l Delete one or all resources from any pending email or client portal posting distributions.

l Save time by quickly duplicating a previous distribution using the Copy option—for
quicker future distributions, reuse and edit details.

Editing a distribution

Note: Content that's already been distributed cannot be edited or deleted.
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1. From the Communications menu, click Calendar.

2. Find the appropriate pending distribution, then click the resource to display distribution
details.

3. Click Edit, then enter appropriate values for the editable fields:

Field Values

On a per resource basis l Distribution send on—this datemust occur on or after today's
date

l Posting expires on

l Posting category

l Merge fields

On a per distribution basis l Recipients—this includes agency contacts notified of the
distribution

l Sender

l Email options—this includes the email template, subject, and
body

Deleting a distribution

Important:
The option to post content to a client portal is only available to agencies that have purchased a client portal.

Note: Deleting a client portal posting that's already been distributed will expire the posting. This will not delete the

distribution record, as it will be maintained in the Distribution history.

1. From the Communicationsmenu, click Calendar.

2. Find the appropriate distribution, then click on it.

3. From the Email Details or Post Details window, click Delete.

Note: You can only delete distributions that you created and distributions being sent on your behalf.
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Note: This will cancel any pending emails and client portal postings, or expire any current client portal postings.

Deleting a resource from a distribution

1. From the Calendar, click on the distribution you wish to delete a resource from.

2. From the Email Details or Post Details window, click Edit.

3. From the Edit Your Email or Edit Your Post window, look to Content to be sent, then
click Edit.

4. From the relative row of the resource you wish to remove, click delete (x).

5. Click Update to save the changes that were made to this distribution.

Copying an email distribution

Note: These same instructions can be followed to copy a portal posting distribution.

1. From the navigation sidebar, click Calendar.

2. Locate a distribution, then click on it.

3. From the Email Details window, click Edit or View distribution.

4. From the Edit Your Email or Review Your Email screen, look to the upper-right and click
Copy distribution.

5. Edit the distribution, as needed.

6. Click Send.
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Collecting success data with reporting
Perhaps you're curious to see who's been receiving your distributions, who's been opening your
distributions, who's been using the content within your distributions, and more. Obtain detailed
or summary information about your Broker Briefcase® distributions, content, or usage by run-
ning a report.

Communication tracking reports

Email Statistics Dashboard
Continue to distribute the most valuable emails by viewing detailed distribution feedback on the
Email Statistics Dashboard. Identify emails your clients find valuable by analyzing exact data on
the emails you send. From the number of emails delivered to the percentage of unique clicks,
gain insight on who's viewing your distributions.

Important:
This report will only include data from the date that Broker Briefcase® started recording data for this report. Look to
the top of the page to view this date.

1. From the Broker Briefcase® navigation sidebar, click Reports.

2. From the Communication tracking tab, look to the Email Statistics Dashboard.

3. Enter a Date range.

Note: Results will only show statistics for the selected date range.

4. To narrow the graph results, look to the list of fields to the right of the graph, then select
only the fields you wish to view.
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Tip: View more information on each statistic with Email Statistics Dashboard: What Does This Mean? by clicking
Here in the blue tip box at the bottom-right of the dashboard.

Filtering the Email Statistics Dashboard by specific accounts or contacts

1. From the top of the dashboard, click Filter.

2. Select whether to filter by Accounts or Account contacts.

3. To narrow results even further, enter an account or contact name, then click Search
(magnifying glass).

4. To add all the results, click Select all; or, to add individual accounts or contacts, click Add
(+) from the account's or contact's relative row.

5. When finished selecting accounts or contacts, click Confirm.

Distributions by Account
View content that's been emailed or posted during a specific time period, by account. Gain
insight on how often this content is used by recipients.

Note: The data that appears in this report is determined by the date range selected on the reporting home page.
Only distributions scheduled within this date range will be returned.
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Fields shown:

l Account name

l Account status

l Contact name

l Contact status

l Content title

l Content language

l Distribution date

l Distribution type

l Content group name

l Total views

Note: The value that appears for Total views will reflect all views of the content since it was distributed—not just
the number of views within the date range selected.

Distributions by Date
View a detailed list of emails or posts sorted by dated distributed, for a specific time period, to
gain insight on how often your agency is reaching out to clients.

Note: The data that appears in this report is determined by the date range selected on the reporting home page.
Only distributions scheduled within this date range will be returned.

Tip: Filter by individual for a clearer picture of which user at your agency scheduled a specific distribution.

Fields shown:

l Distribution date

l Content title

l Content group name

l Distribution type

l Recipient

l Posting category

l Contact status

l Distribution by

l Distributed on behalf of

l Expiration date

l Account status

Distributions of Campaigns
View campaigns that were distributed over a specific time period, as well as how often the cam-
paign was used by recipient, to gain insight on reusable campaigns.

Note: The data that appears in this report is determined by the date range selected on the reporting home page.
Only distributions scheduled within this date range will be returned.
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Fields shown:

l Content group name

l Content title

l Content language

l Distribution type

l Total distributions

l Total recipients

l Total views

Note: The value that appears for Total views will reflect all views of the content since it was distributed—not just
the number of views within the date range selected.

Distributions with Errors
View a summary of distributions with errors for a specific time period, as well as error details,
to ensure distribution errors are fixed.

Fields shown:

l Distribution date

l Content title

l Content language

l Distributed by
l Error messages

Lists
View the public and private recipient lists currently available, as well as recipient details, to
ensure recipient lists are up-to-date.

Tip: Filter by account for a clearer picture of which recipients received a given distribution.

Fields shown:

l List name

l Created by

l Public/Private

l Member

l Email address

l Account status

l Contact status

Portal Postings by Account
View a detailed list of content that's been posted to your clients' portals to keep track of con-
tent your agency has been distributing.
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Important:
This report is only available for Broker Briefcase® users with access to client portals.
For more information, contact your Zywave Account Executive.

Fields shown:

l Account name

l Contact name

l Content title

l Content language

l Posting category

l Expiration date

l Posted by

Broker/client usage reports

Broker Logins
View how often users at your agency log in to Broker Briefcase®, as well as the last time they
logged in, to gain insight on Broker Briefcase® usage at your agency.

Note: The data that appears in this report is determined by the date range selected on the reporting home page.
Only distributions scheduled within this date range will be returned.

Fields shown: 

l User first name

l User last name

l Total logins

l Last login

Note: The value that appears for Total views will reflect all views of the content since it was distributed—not just
the number of views within the date range selected.

Lead Broker Briefcase® Users
View a detailed list of emails and posts for a specific time period, sorted by user, to gain insight
on your top users at your agency.

Note: The data that appears in this report is determined by the date range selected on the reporting home page.
Only distributions scheduled within this date range will be returned.
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Fields shown:

l User first name

l User last name

l Content group name

l Distribution date

l Distribution type

l Content title

l Recipient

Most Popular Client Content
View a detailed list of content that's being used by clients via their client portal to gain insight
on what topics they're most interested in.

Important:
This report is only available for Broker Briefcase® with access to client portals.
For more information, contact your Zywave Account Executive.

Note: The data that appears in this report is determined by the date range selected on the reporting home page.
Only distributions scheduled within this date range will be returned.

Fields shown:

l Account name

l Content title

l Account status

l Contact name

l Contact status

l Total views

Note: The value that appears for Total views will reflect all views of the content since it was distributed—not just
the number of views within the date range selected.

Top Viewed Distributed Content
View how often emailed or posted content is clicked on by clients, for a specific time period, to
gain insight on what distributions they find most valuable.

Note: The data that appears in this report is determined by the date range selected on the reporting home page.
Only distributions scheduled within this date range will be returned.
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Fields shown:

l Content title

l Content language
l Total views

Note: The value that appears for Total views will reflect all views of the content since it was distributed—not just
the number of views within the date range selected.

Available content reports

Content Groups
View a detailed list of the content groups currently available in Broker Briefcase® to gain
insight on valuable campaigns to distribute to clients.

Note: Fields donated with an asterisk (*) can be found in both the Microsoft®Excel® and Word® version of this
report.

Fields shown:

l Content group name*

l Content group description*

l Schedule type*

l Content title*

l Distribution date*

l Source*

l Public/Private*

Content
View a detailed list of content that's currently available in Broker Briefcase® to gain insight on
valuable content to distribute to clients.

Note: Fields donated with an asterisk (*) can be found in both the Microsoft® Excel® and Word® version of this
report.
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Fields shown:

l Content title*

l Content description*

l Content tags

l Content language*

l Line of business

l Source

l Content merge fields

Portal Content
View a detailed list of content currently available to clients via their client portal to gain insight
on content they may find valuable.

Important:
This report is only available for Broker Briefcase® users with access to client portals.
For more information, contact Zywave Account Executive.

Note: Fields donated with an asterisk (*) can be found in both the Microsoft® Excel® and Word® version of this
report.

Fields shown:

l Content title*

l Content description*

l Content tags*

l Content language

l Line of business

l Source

l Content merge fields

Running a Report

1. From the Broker Briefcase® navigation sidebar, click Reports.

2. Locate the report you wish to run.

3. If prompted, enter a Date range.

Note: The data range selected will determine the data that's returned in your report.If prompted, select a Line of
business.
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4. If prompted, select which Accounts or Users to filter the report by.

5. Select your desired output:

6. If necessary, to remove unwanted columns:

a. Click Refine...

b. From the Edit Report Data window, click the (x) icon next to any unwanted
columns; or, click Restore defaults to add the columns back.

c. Click Save.

7. Click Export data, then wait for the Report Execution Progress window to load.

8. Click Open or Save, as appropriate.

Note: When a large amount of data is returned in an Microsoft® Excel® report, a new tab will be created in the
spreadsheet.

Filtering reports using Microsoft® Excel®

Customize a report to only show information you need by applying filters. While you're able to
filter by any criteria within the report, here are a few that are most commonly used:

l Content tags.

l Content merge fields.

l Account.

l Content views.

l Individuals.
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How to set filters
1. Run a report.

2. Highlight the column headers (shown in blue).

3. From the toolbar look to Home > Editing.

4. Click Sort and Filter > Filter.

For more information on filtering a report, refer to Microsoft® Excel® Help.

To filter by content tags using Microsoft® Excel® 2007
1. Click the drop-down arrow for the Tags or Merge fields column, as appropriate.

2. Scroll to Text filters, and click Contains.

3. Click the Or/And option, then enter appropriate filter text.

Tip: If you surround your filter with asterisks (*), only the tags that include this term will be shown; for instance, if
you enter *safety* the report will be filtered to show each tag that includes this term.

4. Click OK and this report will filter to only show instances that have your filter text.

Filtering by account
To display results for a specific account, you may want to filter a report—such as the
Distribution—by account report; to do this filter by account.

To filter by account using Microsoft® Excel® 2007
1. Click the Account column drop-down arrow.

2. From the account list, click (Select all) to clear all options.

3. Scroll through the account list, and select the accounts you want to view in this report.

4. To apply this filter, click OK.

Filtering by content views
To display resources by the number of views, you may want to filter a report—such as the
Distributions by content groups report); to do this filter by content views.
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To filter by content views using Microsoft® Excel® 2007
1. Click the Views column drop-down arrow.

2. As appropriate, click Sort smallest to largest or Sort largest to smallest.

Filtering by individuals
To display results sent or received by a certain individual, you may want to filter a report—such
as the Distributions with errors report; to do this filter by one of the following: account contact,
created by, recipient, or distributed by.

Filtering by an individual using Microsoft® Excel® 2007
To filter by an individual—by an account contact, created by, distributed by—follow these steps: 

1. In the column you want to filter, click the drop-down arrow.

2. From the member list, click (Select all) to clear all options.

3. Scroll through the member list, then select the individuals you want to view in your
report.

4. To apply this filter, click OK.

Tips for formatting your report
To quickly adjust the columns in your report to auto-fit, do the following:

Important:
This must be done before you freeze panes in your report.

l Press CTRL + A to select all the columns, then double-click any boundary between
column headings.

To freeze the title, subtitle, and column headings in your report, do the following:

l Below the rows you want to keep visible when you scroll, select the rightmost
cell.

l Click the View tab.

l From the Window group, select Freeze panes > Freeze panes.
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Administrative features
As an administrative user, you can further manage the content and distribution processes of
Broker Briefcase® from behind the scenes.

Managing agency users

Effortlessly add, edit, or delete agency users by accessing the Account Management Center
Manage Users page right from Broker Briefcase®. From the navigation sidebar, look to
Communications, and selectManage Accounts. From the Account Management Center, go to
Setup > View user list.

Creating an email template for future distributions

Create a branded agency custom email template to be used by anyone at your agency for any
distribution. Just copy an email template from the Email Template Gallery, then edit the copied
email template to fit your needs.

1. From the Broker Briefcase® navigation sidebar, look to Communications, then click Email
Template Gallery.

2. From the Email Template Gallery, locate the email template you wish to copy, then click
Select.

3. From the Email Template Administration page, click Copy and you will be redirected to
the copied template.

4. From the copied template, edit the template Title, Description, and Subject.

5. As desired, edit the template sections.

Note: If you're not finished creating your email and would like to return to it at a later time, click Save as draft and a

hidden draft of the template will be saved in the Email Template Gallery.
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6. When finished, click Publish and the template will be saved under Custom in the Email
Template Gallery.

For more information on editing an email template, look to "Editing the email template" on page 60.

Creating a Classic email template for future distributions
Take full control of your branding and design by building a Classic email template from the
ground up with CSS and HTML source code.

Important:
This is recommended for advanced users with CSS and HTML coding experience.

Note: When viewing the Email Template Gallery, agency users will see the word Classic at the top of the template's
thumbnail.

1. From the Broker Briefcase® navigation sidebar, look to Communications, then click Email
Template Gallery.

2. From the Email Template Gallery, look to the bottom of the page and click Or; to use
CSS and HTML source code to create your email, click here to create your own.

3. From the Email Template Administration page, enter the template Title, Description,
and Subject.

4. From the email body, click Source, then begin entering CSS and HTML.

Note: If you're not finished creating your email and would like to return to it at a later time, click Save as draft and a

hidden draft of the template will be saved in the Email Template Gallery.

5. When finished, click Publish and the template will be saved under Custom in the Email
template Gallery.

For more information on creating a Classic email template with CSS and HTML code, look to "Creating a Classic custom email template"
on page 64.

Deleting or hiding email templates

Keep your custom email templates up-to-date by deleting old templates that no longer fit your
agency's needs. Don't want other users to view an email template? No problem. Broker
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Briefcase® gives you the option to hide Zywave or custom email templates from other users at
your agency.

Deleting an email template

Note: Zywave default templates cannot be deleted. Only custom email templates and copies of Zywave default
templates can be deleted.

1. From the Broker Briefcase® navigation sidebar, look to Communications, then click Email
Template Gallery.

2. From the Email Template Gallery, click Custom.

3. From the email template you wish to edit, click Select.

4. From the Email Template Administration page, click Delete.

Hiding an email template from other agency users

How? To hide a Zywave email template, from the Email Template Administration page, select Hide template.

How? To hide an agency custom email template—including copied Zywave templates—save the template as a draft.

Importing custom content

You can improve your distribution process by importing custom content your agency distributes
the most into Broker Briefcase®.

Note: The upload system will automatically detect merge fields in your content when uploading. Make sure merge
fields are formatted properly in your content before uploading so the system can detect them.
For more information on formatting merge fields, look to theMerge Fields Reference Guide in Broker Briefcase® Help > Additional
resources.

1. From the Broker Briefcase® navigation sidebar, look to Content, then click Custom
Content.

2. From the Custom Content page, click Import content.

3. From the Import Content window, click Browse to select content you want to import.
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Note: To add a Spanish version of this content, look under the Browse button and click + Add Spanish version.

4. Enter a Content Name.

5. As necessary, enter a Description that can be seen when the content is searched by
users.

6. From the Content tags field, click the Select category drop-down.

7. Select a category, then select the tag you want to apply from that category.

Note: Some categories will have tags automatically included with upload; for instance, if you select the

Type/Format category, your upload will automatically include the tag for Microsoft® Word®, Excel®, and so on
based on the format of the content you're uploading.

8. As necessary, add more tags.

9. As necessary, selectMake this content available to other locations?

Important:
The multiple locations feature is only available to users with global administrative rights.

Note: From the additional locations table, clicking Add all locations will automatically include any additional agency
locations added in the future. Future locations will not be included automatically if selected individually.

10. When finished, click Upload.

Editing or deleting custom content

Keep your custom agency content up-to-date by continuously editing it, and keep it organized by
deleting any content that no longer fits your agency's needs.

Editing custom content
1. From the Broker Briefcase® navigation sidebar, look to Content, then click Custom

Content.

2. Locate the content you wish to edit.

3. Click View to open the content details page.



Broker Briefcase® User's Guide

Page 86

4. Look to the right of the content image, then click Edit.

5. If applicable:

l Edit the Content name or Description.

l To add or remove keyword tags, look to Content tags.

l Select whether or not to upload the resource to multiple locations.

Note: Each custom agency resource will be automatically tagged with they keyword Imported content, and the
appropriate file type tag; such as, a Microsoft® Word® document, or PDF.

6. When finished, click Save.

Deleting custom content
1. From the Broker Briefcase® navigation sidebar, look to Content, then click Custom

Content.

2. Locate the content you wish to delete.

3. Click View to open the content details page.

4. Look to the right of the content image, then click Delete.

Customizing posting categories

If you have MyWave® portals, you can post content to them directly from Broker Briefcase®.
When posting content, you'll need to select a category in which the content will be posted. You
will find a menu of default categories in the Post to this category drop-down.

Note: Posting categories will only show in MyWave® and MyWave Elements® portals. Content will still be posted in
MyWave Connect®, but no categories will be assigned.

Adding a new posting category
Add new posting categories if the default posting categories in Account Management Center
don't fit your agency's needs.
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Note: Posting categories will only show in MyWave® and MyWave Elements® portals. Content will still be posted in
MyWave Connect®, but no categories will be assigned.

1. From the Broker Briefcase® navigation sidebar, look to Communications, then click
Posting Categories. This will redirect you to the Account Management Center.

2. Click Create new category.

3. Enter an appropriate name for this posting category.

4. To adjust the order of this category in relation to the others, point to the posting category
number, then use the Up and Down arrows.

5. Click Save changes when finished, or Cancel all changes to discard all changes made.

Editing a posting category
Edit a posting category if you feel the name doesn't fit your agency's needs, or reorder posting
categories if you feel they should be arranged differently.

1. From the Broker Briefcase® navigation sidebar, look to Communications, then click
Posting Categories. This will redirect you to the Account Management Center.

2. From the row of the category you wish to edit, click the category name.

3. To rename this posting category, enter a new name in the text field.

4. To adjust the order of this category in relation to the others, point to the posting category
number, then use the Up and Down arrows.

Tip: To restore a posting category name back to its Zywave default, look to the right of the category name text box,

then click the Revert icon.

5. Click Save changes when finished, or Cancel all changes to discard all changes made.

Deleting an existing posting category
If you feel that a posting category in Broker Briefcase® will not be used by your agency, you
have the option to delete it.
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Note: Zywave default categories, and categories with content currently posted to them, cannot be deleted. Only
custom categories that don't have any content posted to them can be deleted.

1. From the Broker Briefcase® navigation sidebar, look to Communications, then click
Posting Categories. This will redirect you to the Account Management Center.

2. From the row of the category you wish to delete, click the Delete checkbox.

3. Click Save changes when finished, or Cancel all changes to discard all changes made.
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Best practices with Broker Briefcase®
Broker Briefcase® is the ultimate marketing communications tool and can help take your
agency to new heights when the application is used to its full capacity. Follow these best prac-
tices to get the most out of your Zywave tool.

Best practices with searching for content

Save time and narrow your content library search by selecting a search option, and ensure your
search terms return results you expect by using the following advanced search features!

Selecting a search option
When searching the Broker Briefcase® content library, click:

Using advanced search features

Search feature Description

"" Inserting double quotes around a term ensures the exact
wording and word choice is searched.

Example: A search for food services will include results where
either or both terms (food and/or services) appear. However, a
search for "food services" will include results with that specific
phrase.
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Search feature Description

+ Adding a plus sign immediately before a word pulls in
content that contains the word exactly as you spelled it.

Example: A search for +health care will not include results
containing healthcare.

OR Entering OR between topics pulls content containing either
search topic.

Example: A search for health care OR reform will give you results
about either topic, whereas health care reform will show content
focused on this specific topic.

- Adding a minus sign immediately before a word excludes this
word from the search results.

Example: A search for electricity -newsletters will exclude any
newsletters related to electricity.

Best practices with using content groups

There are a few different ways that you can use content groups to demonstrate your agency
value while enhancing your daily workflow.

Conveniently set-it-and-forget-it

We know you're busy so we've developed a way for you to take advantage of drip marketing
and effortlessly send your clients and prospects content all-year-round. Set up a drip marketing
campaign by scheduling a distribution date for each resource within a content group, then for-
get it and let Broker Briefcase® do the rest.

For more information on creating a drip marketing campaign, look to Drip Marketing Best Practices in Broker Briefcase® Help >

Additional resources.
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Fit your clients' needs

If you want to quickly create a custom content group to fit your clients' needs, customize a
Zywave default content group by merely adding or removing any content and adjusting the dis-
tribution dates.

For more information on creating a content group, look to "Creating, editing, or deleting a content group" on page 52.

Distribute targeted content

Want to create a content group from scratch that's completely tailored to your clients' needs?
Find and select pieces of content by subject, line of business, industry, and more and add them
to your Action Items to create a custom, targeted content group.

For more information on adding content to your Action Items, look to "Grouping content in Action Items" on page
50.

Create reusable campaigns

You can save time and create reusable campaigns from content groups. To make it more per-
sonal, create email templates that target each audience you distribute to, then distribute the
campaign any number of times using your customized email templates.

Important:
Only administrative users can create reusable email templates.
For more information, contact your administrator.

For more information on creating an email template, look to "Editing the email template" on page 60.

Distribute up-to-date legislative content

Conveniently distribute the latest legislative content to your clients by compiling it into a con-
tent group that you can distribute whenever Zywave experts update this content.

For more information on creating a content group, look to "Creating and maintaining content groups" on page 50.

Best practices with distribution

Save time when setting up a distribution by saving recipients you regularly send content to as a
list, and by setting up a default email template for all your distributions. Also, ensure your dis-
tributions are successful by taking a look at our recommended distribution methods.
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Choosing the most successful distribution method
We recommend using the distribution features Email and Post rather than downloading hard
copy to your desktop. Here's why:

l Download: Your clients may not receive the most up-to-date information because this
option creates a static version of the resource that remains unchanged unless you manu-
ally edit it.

l Emailing or Posting: You clients will receive the most up-to-date information because
these options allow a resource to be reviewed by Zywave experts and updated con-
sistently.

Saving recipients you regularly send content to as a List
Do you distribute to list of contacts on a regular basis? If so, you may want to save this set of
recipients as a list. For instance, you can segment contacts by size, line of business, or preferred
level of communication, and target each group with resources to suit their unique needs. Con-
veniently customize and save a group of:

l Individual account contacts

l Accounts

l Other lists

Creating a recipient list

1. From the distribution window, click To.

2. From the Search Recipients window, add the desired recipients.

3. From the bottom of the window, select Save recipients as a list.

4. Click Confirm.

5. From the Save as List window, enter a List name .

6. Select whether to make this list Public to everyone, or Private.

7. Click Save when finished, or click Cancel to discard any changes.
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Note: You can also create lists by looking to the Communicationsmenu clicking Lists from the navigation sidebar.

To add an appropriate list name and recipients, click Create list.

Selecting contacts for a new or an existing list

1. From the navigation sidebar look to Communications, then click Lists. This will redirect
you to the Account Management Center.

2. ClickMore > Edit for the appropriate list.

3. Click to Add members.

4. From the Edit Your List window, enter a partial or entire contact name in the search bar.

Note: You can locate recipients by selecting a filtering option and browsing through Accounts, Contacts, or Lists.

5. Select the account you'd like to distribute to by clicking the account name; or, to dis-
tribute to only one contact, click View contacts.

6. If necessary, manually enter recipient email addresses.

7. Click Save.

Removing a contact from a list

1. From the navigation sidebar look to Communications, then click Lists. This will redirect
you to the Account Management Center.

2. ClickMore > Edit for the appropriate list.

3. In the respective row of the contact you'd like to remove from the list, click delete (x).

4. Click Save.

Deleting a list

1. From the navigation sidebar look to Communications, then click Lists. This will redirect
you to the Account Management Center.

2. ClickMore > Edit for the appropriate list.

3. In the respective row of the list you'd like to remove, click delete (x).

4. Click Save.
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Setting a default email template to start all your distributions with
Do you find yourself using the same email template for the majority of your distributions? Set
your most commonly used email template as your global default and each distribution you cre-
ate will automatically start with that template.

Note: Only administrative users can set a default email template.

To set a default email template:

1. Look to the Communicationsmenu in the navigation sidebar, and select Email Template
Gallery.

2. From the Email Template Gallery, locate your desired email template and click Select.

3. Select the Set as my global default template checkbox.

Best practices with Broker Briefcase® and other Zywave tools

Make life a little easier by taking advantage of Zywave tool integration features. To learn if
another tool you own integrates with Broker Briefcase®, take a look at the following best prac-
tices!

Account Management Center and Broker Briefcase®
Populating Account Management Center with your clients' information integrates seamlessly
with Broker Briefcase®, allowing you to use your Zywave tools to their full potential. Bring valu-
able content to the forefront with Broker Briefcase®—start by grouping accounts and contacts
from Account Management Center into Lists, and then deliver value with one-off distributions
or marketing campaigns.

Note: If you own BrokerageBuilder™, it can be used in place of Account Management Center.
For more information look toBrokerageBuilder™ Help, or contact Partner Support at 866.499.9283.
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For more information on Account Management Center and Broker Briefcase®, see Account Management Center and Broker
Briefcase® Best Practices in Account Management Center Help.
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Glossary

Action Items
Action Items is a holding place or shopping cart for content. You can store and group
content before distribution in your Action Items; for example, if you'd like to distribute
multiple resources at one time, you can find a resource, add it to your Action Items, and
continue searching and queuing up to 60 resources. Then, from the Action Items tab,
use the same streamlined distribution process you see when distributing a single
resource.

Advanced users
Users who can read CSS and HTML source code.

Classic email template editor
The Classic email template editor is where you have the option to edit or create email
templates with CSS and HTML source code. This is recommended for advanced users
with CSS and HTML coding experience.

Content group
Content groups provide a way to group a set of related content and distribute it over a
given period of time.

CSS
A style sheet language used for describing the look and formatting of a document writ-
ten in a markup language.

Custom content or template
Custom content or templates are created by administrative users at your agency.

HTML
Hypertext Markup Language (HTML) is a standardized system for tagging text files to
achieve font, color, graphic, and hyperlink effects on World Wide Web pages.

Keyword tags
Keyword tags are keywords that Zywave experts tag content with to make it easier for
you to find; for example, if Zywave tagged content with the keyword "Broker," then
when you search Broker all the content containing that keyword tag would show up in
your search results.
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Merge fields
Merge fields are placeholders found in a Broker Briefcase content or email templates.
During the distribution process, these fields are filled in with your agency and client
data from the Broker Briefcase database, or from data you enter manually. When in a
resource, merge fields are surrounded by square brackets; for example, [b_address]
refers to your broker address. During the distribution process, this field is filled in with
your agency's address, such as "123 Main St." There are a number of built-in merge
fields that come with Broker Briefcase. Additionally, you can create your own custom
merge fields.
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